MCP19214/5
Monitoring
Graphical User Interface
User’s Guide
Note the following details of the code protection feature on Microchip devices:

- Microchip products meet the specification contained in their particular Microchip Data Sheet.
- Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the intended manner and under normal conditions.
- There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data Sheets. Most likely, the person doing so is engaged in theft of intellectual property.
- Microchip is willing to work with the customer who is concerned about the integrity of their code.
- Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Information contained in this publication regarding device applications and the like is provided only for your convenience and may be superseded by updates. It is your responsibility to ensure that your application meets with your specifications. MICROCHIP MAKES NO REPRESENTATIONS OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY OR OTHERWISE, RELATED TO THE INFORMATION, INCLUDING BUT NOT LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE, MERCHANTABILITY OR FITNESS FOR PURPOSE. Microchip disclaims all liability arising from this information and its use. Use of Microchip devices in life support and/or safety applications is entirely at the buyer’s risk, and the buyer agrees to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights unless otherwise stated.

Trademark List

The Microchip name and logo, the Microchip logo, AnyRate, AVR, AVR logo, AVR Freaks, BeaconThings, BitCloud, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, Helder, JukeBlox, Keeloq0, Keeloq logo, Keeloq, LANcheck, LINK MD, maxStylus, maxTouch, MediaLB, megaAVR, MOST, MOST logo, MPLAB, OptoLyzer, PIC, picPower, PICSTART, PIC32 logo, Prochip Designer, QTouch, RightTouch, SAM-BA, SpyNIC, SST, SST Logo, SuperFlash, tinyAVR, UNI/O, and XMEGA are registered trademarks of Microchip Technology Incorporated in the U.S.A. and other countries.

ClockWorks, The Embedded Control Solutions Company, EtherSynch, Hyper Speed Control, HyperLight Load, IntelliMOS, mTouch, Precision Edge, and Quiet-Wire are registered trademarks of Microchip Technology Incorporated in the U.S.A.


SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

Silicon Storage Technology is a registered trademark of Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.

© 2016, Microchip Technology Incorporated, All Rights Reserved.

ISBN: 978-1-5224-1202-1

Microchip received ISO/TS-16949:2009 certification for its worldwide headquarters, design and wafer fabrication facilities in Chandler and Tempe, Arizona; Gresham, Oregon and design centers in California and India. The Company’s quality system processes and procedures are for its PIC® MCUs and dsPIC® DSCs, Keeloq code hopping devices, Serial EEPROMs, microperipherals, nonvolatile memory and analog products. In addition, Microchip’s quality system for the design and manufacture of development systems is ISO 9001:2000 certified.
Object of Declaration: MCP19214/5 Monitoring Graphical User Interface

EU Declaration of Conformity

This declaration of conformity is issued by the manufacturer. The development/evaluation tool is designed to be used for research and development in a laboratory environment. This development/evaluation tool is not a Finished Appliance, nor is it intended for incorporation into Finished Appliances that are made commercially available as single functional units to end users under EU EMC Directive 2004/108/EC and as supported by the European Commission's Guide for the EMC Directive 2004/108/EC (8th February 2010). This development/evaluation tool complies with EU RoHS2 Directive 2011/65/EU. This development/evaluation tool, when incorporating wireless and radio-telecom functionality, is in compliance with the essential requirement and other relevant provisions of the R&TTE Directive 1999/5/EC and the FCC rules as stated in the declaration of conformity provided in the module datasheet and the module product page available at www.microchip.com. For information regarding the exclusive, limited warranties applicable to Microchip products, please see Microchip’s standard terms and conditions of sale, which are printed on our sales documentation and available at www.microchip.com. Signed for and on behalf of Microchip Technology Inc. at Chandler, Arizona, USA.

Derek Carlson
VP Development Tools

11-NOV-16

Date
Table of Contents

Preface ........................................................................................................................... 7
  Introduction .................................................................................................................. 7
  Document Layout ........................................................................................................ 7
  Conventions Used in this Guide .................................................................................. 8
  Recommended Reading ............................................................................................... 9
  The Microchip Web Site ............................................................................................. 9
  Customer Support ..................................................................................................... 9
  Document Revision History ..................................................................................... 9

Chapter 1. Product Overview
  1.1 Introduction ....................................................................................................... 11
  1.2 MCP19214/5 Monitoring Graphical User Interface Overview ......................... 11
  1.3 The Development System's Components ........................................................ 11

Chapter 2. Installation and Operation
  2.1 Getting Started .................................................................................................... 13
  2.2 Graphical User Interface (GUI) Installation ...................................................... 13
  2.3 Driver Installation for the Adapter ...................................................................... 19
  2.4 MCP19214_5Monitor Software Uninstall .......................................................... 23

Chapter 3. Graphical User Interface
  3.1 Introduction ....................................................................................................... 25
  3.2 Graphical User Interface Description .................................................................. 25
  3.3 Using the MCP19214/5 Graphical User Interface ............................................. 33

Worldwide Sales and Service ..................................................................................... 36
NOTES:
Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our web site
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP19214/5 Monitoring Graphical User Interface. Items discussed in this chapter
include:

- Document Layout
- Conventions Used in this Guide
- Recommended Reading
- The Microchip Web Site
- Customer Support
- Document Revision History

DOCUMENT LAYOUT

This document describes how to use the MCP19214/5 Monitoring Graphical User
Interface as a development tool to emulate and debug firmware on a target board. The
manual layout is as follows:

- Chapter 1. “Product Overview” – Important information about the MCP19214/5
  Monitoring Graphical User Interface.
- Chapter 2. “Installation and Operation” – Includes instructions on how to get
  started with MCP19214/5 Monitoring Graphical User Interface.
- Chapter 3. “Graphical User Interface” – Describes the MCP19214/5 Monitoring
  Graphical User Interface and includes instructions on how to use it.
CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

### DOCUMENTATION CONVENTIONS

<table>
<thead>
<tr>
<th>Description</th>
<th>Represents</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arial font:</td>
<td>Referenced books</td>
<td><em>MPLAB® IDE User’s Guide</em></td>
</tr>
<tr>
<td>Italic characters</td>
<td>Emphasized text</td>
<td><em>...is the only compiler...</em></td>
</tr>
<tr>
<td>Initial caps</td>
<td>A window</td>
<td>the Output window</td>
</tr>
<tr>
<td></td>
<td>A dialog</td>
<td>the Settings dialog</td>
</tr>
<tr>
<td></td>
<td>A menu selection</td>
<td>select Enable Programmer</td>
</tr>
<tr>
<td>Quotes</td>
<td>A field name in a window or dialog</td>
<td>“Save project before build”</td>
</tr>
<tr>
<td>Underlined, italic text with right angle bracket</td>
<td>A menu path</td>
<td><em>File&gt;Save</em></td>
</tr>
<tr>
<td>Bold characters</td>
<td>A dialog button</td>
<td>Click <em>OK</em></td>
</tr>
<tr>
<td></td>
<td>A tab</td>
<td>Click the <em>Power</em> tab</td>
</tr>
<tr>
<td>N’Rnnnn</td>
<td>A number in verilog format, where N is the total number of digits, R is the radix and n is a digit.</td>
<td>4'b0010, 2'hF1</td>
</tr>
<tr>
<td>Text in angle brackets &lt; &gt;</td>
<td>A key on the keyboard</td>
<td>Press <em>&lt;Enter&gt;, &lt;F1&gt;</em></td>
</tr>
<tr>
<td>Courier New font:</td>
<td>Sample source code</td>
<td>#define START</td>
</tr>
<tr>
<td>Plain Courier New</td>
<td>Filenames</td>
<td>autoexec.bat</td>
</tr>
<tr>
<td></td>
<td>File paths</td>
<td>c:\mcc18\h</td>
</tr>
<tr>
<td></td>
<td>Keywords</td>
<td>_asm, _endasm, static</td>
</tr>
<tr>
<td></td>
<td>Command-line options</td>
<td>-Opa+, -Opa-</td>
</tr>
<tr>
<td></td>
<td>Bit values</td>
<td>0, 1</td>
</tr>
<tr>
<td></td>
<td>Constants</td>
<td>0xFF, ‘A’</td>
</tr>
<tr>
<td>Italic Courier New</td>
<td>A variable argument</td>
<td>file.o, where <em>file</em> can be any valid filename</td>
</tr>
<tr>
<td>Square brackets [ ]</td>
<td>Optional arguments</td>
<td>mcc18 [options] file [options]</td>
</tr>
<tr>
<td>Curly brackets and pipe character: {</td>
<td>Choice of mutually exclusive arguments; an OR selection</td>
<td>errorlevel {0</td>
</tr>
<tr>
<td>Ellipses...</td>
<td>Replaces repeated text</td>
<td>var_name [, var_name...]</td>
</tr>
</tbody>
</table>
| | Represents code supplied by user | void main (void) {
| | | ...} |
RECOMMENDED READING

This user’s guide describes how to use the MCP19214/5 Monitoring Graphical User Interface. Other useful documents are listed below. The following Microchip documents are available and recommended as supplemental reference resources.

- MCP19214/5 Data Sheet – “Digitally Enhanced Power Analog, Dual Channel, Low-Side PWM Controller” (DS20005681)

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web site is used as a means to make files and information easily available to customers. Accessible by using your favorite Internet browser, the web site contains the following information:

- **Product Support** – Data sheets and errata, application notes and sample programs, design resources, user’s guides and hardware support documents, latest software releases and archived software
- **General Technical Support** – Frequently Asked Questions (FAQs), technical support requests, online discussion groups, Microchip consultant program member listing
- **Business of Microchip** – Product selector and ordering guides, latest Microchip press releases, listing of seminars and events, listings of Microchip sales offices, distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

- Distributor or Representative
- Local Sales Office
- Field Application Engineer (FAE)
- Technical Support

Customers should contact their distributor, representative or field application engineer (FAE) for support. Local sales offices are also available to help customers. A listing of sales offices and locations is included in the back of this document.

Technical support is available through the web site at: [http://www.microchip.com/support](http://www.microchip.com/support).

DOCUMENT REVISION HISTORY

Rev. A (December 2016)

- Initial release of this document.
Chapter 1. Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the MCP19214/5 Monitoring Graphical User Interface and covers the following topics:

- MCP19214/5 Monitoring Graphical User Interface Overview
- The Development System’s Components

1.2 MCP19214/5 MONITORING GRAPHICAL USER INTERFACE OVERVIEW

The MCP19214/5 Monitoring Graphical User Interface is a monitoring and calibration tool used for the MCP19214 or the MCP19215. In order to connect to the device, an MCP2221 USB-to-I²C bridge is used. For the MCP19215 Evaluation Board, the MCP2221 is incorporated on the board. The interface can collect basic parameters from the device: output voltage, input voltage, output current, temperature. Using the tool, the voltages and currents for each channel can be set and calibrated. Time evolution of some output and input parameters can be analyzed on graphics provided by the interface.

1.3 THE DEVELOPMENT SYSTEM’S COMPONENTS

To use the GUI, the following tool is required:

- The MCP19214/5 Monitoring Graphical User Interface. This Graphical User Interface allows monitoring and changing the input and output parameters.

For communication purposes, an MCP2221 USB-to-I²C bridge is used, incorporated on the board. This device allows I/O control and custom device configuration. The interface can collect basic parameters from the device. Values, such as the output voltage, input voltage, output current and temperature can be monitored. The output voltages and currents can be modified using the MCP19214/5 Monitoring Graphical User Interface. The time evolution of some of the parameters measured with the internal Analog-to-Digital Converter (ADC) can be analyzed using the graphs provided by the interface.
Chapter 2. Installation and Operation

2.1 GETTING STARTED

In order to install, use and evaluate the product, there are several software and hardware tools required to be installed and/or set.

2.1.1 Required Software

• MCP19214_5Monitor GUI (v.1.0)
• Microsoft.NET Framework 4.5 or Higher
• Adobe® Reader
• Windows® 7

2.1.2 Required Hardware

2.1.2.1 CONNECTED BOARDS

• MCP19215 Evaluation Board (ADM00799)

![NOTICE]

The MCP19214/5 Monitoring Graphical User Interface must be used with the MCP19215 Evaluation board (ADM00799), connected to the PC, using the incorporated USB connector. Otherwise, the MCP19214/5 Monitoring Graphical User Interface will not be completely functional.

![WARNING]

Use caution when changing certain parameters using the MCP19214/5 Monitoring Graphical User Interface as it may affect the hardware functionality. Please read the data sheet before changing the values provided by the Advanced Setup menu. Make sure a correct value is filled in as there is no verification mechanism.

2.1.2.2 COMMUNICATION TOOLS

• MCP2221 USB-to-i²C bridge – incorporated on the MCP19215 Evaluation Board

![Note]

The board connected to the PC has the adapter incorporated. Only a USB cable is needed for communication; no other adapter is required. Please refer to the board user’s guide.
2.2 GRAPHICAL USER INTERFACE (GUI) INSTALLATION

The following steps describe how to install the MCP19214/5 Monitoring Graphical User Interface:

1. If the Microsoft.NET Framework is already installed, go to Step 3. If not, download the Microsoft.NET Framework from www.microsoft.com and follow the installation instructions.

2. If Adobe Reader is already installed, go to Step 3. If not, download Adobe Reader from http://get.adobe.com/reader/ and follow the installation instructions.

3. Download the MCP19214/5 Monitoring GUI (v.1.0) archive from www.microchip.com/mcp19215, under “Documentation & Software”.

4. Unzip the MCP19214/5 Monitoring GUI (v.1.0) archive, which contains the setup.exe file.

   **Note:** If an older version or a corrupted version of the current MCP19214_5Monitor is already installed on the computer, please see Section 2.4 “MCP19214_5Monitor Software Uninstall” before proceeding with the installation.

5. Double click the setup.exe file to open the InstallShield Wizard window and wait for the extraction to complete. If required, the installation can be stopped by pressing the Cancel button.

   ![Preparing the InstallShield Wizard](image-url)

**FIGURE 2-1:** Preparing the InstallShield Wizard for the MCP19214_5Monitor.
6. In the Welcome to the InstallShield Wizard for MCP19214_5Monitor window, click on the **Next** button to start the installation.

![FIGURE 2-2: Starting the MCP1921_5Monitor Installation.](image)

7. Review and accept the License Agreement by checking the **I accept the terms in the license agreement** option button, then click on the **Next** button.

![FIGURE 2-3: The License Agreement Window.](image)
8. The installation path can be changed, although it is recommended to keep the default path. Click on the **Next** button to continue.

![Selecting the Destination Folder](image)

**FIGURE 2-4:** Selecting the Destination Folder.
9. In the Ready to Install the Program window, click on the **Install** button and wait for the application to proceed with the installation. The progress can be observed in the "Status" bar.

**FIGURE 2-5:** Installing the MCP19214_5Monitor.
10. Once the installation completes, leave the Launch the program box checked to automatically start the MCP19214_5Monitor user interface or deselect this check box to start the GUI at a later stage. Click Finish to end the installation.

To start the GUI at a later stage, either click on the desktop icon or browse to Windows Start>All Programs>Microchip>MCP19214_5Monitor.

FIGURE 2-6: The Installation Complete Window.

11. The interface will display the Basic Settings menu; the scan address and the connect functions will be active.

FIGURE 2-7: Initial Basic Settings Menu.
2.3 DRIVER INSTALLATION FOR THE ADAPTER

If the USB integrated on the board is used, the computer should automatically install the appropriate driver when the evaluation board is connected. If the driver is not installed automatically after installing the GUI, the following steps describe the installation process.

1. Go to Windows Start>Control Panel>System and Security. Choose System from the right panel and click Device Manager from the left pane to open the list of installed hardware. In the “Other devices” list, identify a USB unknown connection.

   Right click on the unknown driver and click on “Update Driver Software”.

![Device Manager – Update Driver](image)

FIGURE 2-8: Device Manager – Update Driver.
2. In the Update Driver Software window, click on “Browse my computer for driver software” option.

3. Click on the **Browse** button and select the path where the GUI was installed. If the path was left unchanged, go to the `C:\Program Files (x86)\Microchip\MCP19214_5Monitor` folder and click the **OK** button. Click **Next** to start the driver installation.
4. If the following warning message appears, select the “Install this driver anyway” option; otherwise, skip this step.

**FIGURE 2-11:** Installing the Driver Software.

**FIGURE 2-12:** Warning Message.
If the driver was successfully installed, the following window will appear:

FIGURE 2-13: *Installing the Driver Software.*

After installation, the device should be recognized in the Device Manager; otherwise, remove and plug in the USB cable again.

FIGURE 2-14: *USB Recognized.*
2.4 MCP19214_5MONITOR SOFTWARE UNINSTALL

In order to install the current MCP19214_5Monitor version, any previous or corrupted version should be removed from the computer.

If there is an older version installed on the computer, the message box from Figure 2-15 will be displayed in Step 5 of the GUI installation process. Uninstall the older version from Windows Start>Control Panel>Programs>Uninstall a Program, then go to Step 5 to resume the installation.

![Windows® Installer Message Box.](image)

**FIGURE 2-15:** Windows® Installer Message Box.

If the current MCP19214_5Monitor version is already installed on the computer, in order to have a clean install, the message box in Figure 2-16 will be displayed in Step 6 of the GUI installation process. In this case, follow the next steps to uninstall the current version of the MCP19214_5Monitor:

1. Select the Remove option button, then click the Next button.

![The Program Maintenance Window.](image)

**FIGURE 2-16:** The Program Maintenance Window.
2. In the Remove the Program window, click the **Remove** button to remove the current MCP19214_5Monitor version from the computer.

![FIGURE 2-17: Removing Previous Installations.](image)

3. When the MCP19214_5Monitor completes the uninstall process, click on the **Finish** button, then go to Step 5 to resume the installation of the MCP19214_5Monitor GUI.

![FIGURE 2-18: Uninstalling the MCP19214_5Monitor.](image)
Chapter 3. Graphical User Interface

3.1 INTRODUCTION

This chapter describes how to use the GUI and the MCP19214/5 device characteristics that are included and monitored.

3.2 GRAPHICAL USER INTERFACE DESCRIPTION

The following sections describe the items in the Graphical User Interface.

3.2.1 Menu Bar

The menu bar contains the items available for the user to display the device’s characteristics and settings, as shown in Table 3-1.

![Menu Bar](image-url)
3.2.2 Connection Bar

The connection bar contains the items in Table 3-2.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Addr</td>
<td>This drop-down menu shows the address of the I2C protocol device.</td>
</tr>
<tr>
<td>Connector</td>
<td>This drop-down menu shows the type of connector used to connect the board to the PC. The connector is automatically recognized. Connect the MCP19214/5 board to the PC by using the USB port on the MCP19214/5 board. In this case, the MCP222X integrated in the MCP19214/5 board is used to perform the communication.</td>
</tr>
<tr>
<td>ScanAddr</td>
<td>This button is used to scan for PMBus protocol devices connected to the PC.</td>
</tr>
<tr>
<td>Connect/Disconnect</td>
<td>These buttons are used to connect/disconnect the PMBus protocol device.</td>
</tr>
<tr>
<td>Voltage</td>
<td>This drop-down menu is used to select the voltage level of the I2C communication interface.</td>
</tr>
<tr>
<td>Rate</td>
<td>This drop-down menu is used to select the corresponding communication rate for the device.</td>
</tr>
<tr>
<td>Pullups</td>
<td>This drop-down menu allows enabling/disabling pull-ups.</td>
</tr>
</tbody>
</table>

**Note 1:** The Disconnect button is disabled when the ScanAddr and Connect buttons are enabled, and enabled when the ScanAddr and Connect buttons are disabled.

3.2.3 Status Bar

The status bar provides information on the status of the device connected to the PC. This bar is available in all the menus.

**FIGURE 3-4:** Status Bar.

The items available in the status bar are shown in Table 3-3.
3.2.4 Basic Settings Menu

The Basic Settings menu is the first tab displayed when opening the MCP19214_5Monitor.

### TABLE 3-3: STATUS BAR ITEMS

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status Label</td>
<td>The status label on the bottom of the GUI shows if there is any device connected to the board. Refer to Table 3-4 for a list of possible labels.</td>
</tr>
<tr>
<td>Progress Bar</td>
<td>The progress bar completes after scanning for the I²C address or when disconnecting from the device.</td>
</tr>
<tr>
<td>Error Label</td>
<td>When a communication error happens, an error label appears between the Status Label and Progress Bar</td>
</tr>
</tbody>
</table>

### TABLE 3-4: STATUS LABELS

<table>
<thead>
<tr>
<th>Status Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>STATUS: Connected!</td>
<td>This message is shown when the GUI detects a device connected to the board.</td>
</tr>
<tr>
<td>STATUS: Disconnected!</td>
<td>This message is shown when the GUI does not detect any device connected to the board.</td>
</tr>
</tbody>
</table>

**FIGURE 3-5:** Initial Basic Settings Menu.

The Basic Settings menu is used to monitor the MCP19214/5 device parameters, to enable/disable the converter, to store/restore values and to set output parameters. The items found in the Basic Settings menu are shown in Table 3-5.
3.2.5 Hardware Setup Menu

The Hardware Setup menu allows setting the resistors’ values for the output feedback dividers and the values for the output shunt resistors. Current values can be saved or older values can be loaded.

The items found in the Hardware Setup menu are shown in Table 3-6.

**FIGURE 3-6: The Hardware Setup Menu.**

The items found in the Hardware Setup menu are shown in Table 3-6.
3.2.6 Advanced Setup Menu

The Advanced Setup menu is used to compensate and calibrate the board. It contains a Settings tab and a Calibration tab.

**TABLE 3-6: HARDWARE SETUP MENU ITEMS**

<table>
<thead>
<tr>
<th>Panel</th>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voltage</td>
<td>R1</td>
<td>Shows the value of the first resistor from the output divider for each channel.(^{1})</td>
</tr>
<tr>
<td></td>
<td>R2</td>
<td>Shows the value of the second resistor from the output divider for each channel.(^{1})</td>
</tr>
<tr>
<td></td>
<td>SET</td>
<td>These buttons are used to set the resistors from the output divider for each channel separately.</td>
</tr>
<tr>
<td>Current</td>
<td>Shunt</td>
<td>Shows the value for the output shunt resistor for each channel.</td>
</tr>
<tr>
<td></td>
<td>SET</td>
<td>These buttons are used to set the output shunt resistors for each channel separately.</td>
</tr>
<tr>
<td></td>
<td>Save profile</td>
<td>This button saves the resistors’ values for the output feedback divider and the values for the output shunt resistors for both channels.</td>
</tr>
<tr>
<td></td>
<td>Load profile</td>
<td>This button loads the resistors’ values for the output feedback divider and the values for the output shunt resistors for both channels.</td>
</tr>
</tbody>
</table>

**Note 1:** The values loaded are the last values used, or the default values, if the Graphical User Interface has just been installed.

**WARNING**

Use caution when changing certain parameters as it may affect the hardware functionality. Make sure a correct value is filled in as there is no verification mechanism. Please read the data sheet before changing the values provided by this menu.
3.2.6.1 Settings TAB

The **Settings** tab is used to compensate the board. The user can change the values from the registers provided and read back the values changed.

![Advanced Setup Menu - Settings](image)

**FIGURE 3-7:** The Advanced Setup Menu – **Settings**.

The items found in the Advanced Setup menu, **Settings** tab, are shown in **Table 3-7**.

**TABLE 3-7: ADVANCED SETTINGS MENU ITEMS**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slope compensation</td>
<td>Holds the digital value that controls the slope compensation ramp.</td>
</tr>
<tr>
<td>LOOPCON1/LOOPCON2</td>
<td>Holds the control bits for the I/V loops for each PWM channel. The outputs from the IVGOOD and IVDOM comparators can be read from this register for each channel.</td>
</tr>
<tr>
<td>I Peak Sense Offset</td>
<td>Holds the digital value that controls the input current offset adjust.</td>
</tr>
<tr>
<td>I Peak Sense Blanking</td>
<td>Holds the digital value that controls the Leading-Edge Blanking (LEB) time on the primary input current.</td>
</tr>
<tr>
<td>VREFCON1/VREFCON2</td>
<td>Holds the digital value that controls the DAC voltage reference ( V_{REF} ), which sets the voltage regulation value for each channel.</td>
</tr>
<tr>
<td>CREFCON1/CREFCON2</td>
<td>Holds the digital value that controls the DAC current reference ( I_{REF} ), which sets the current regulation value for each channel.</td>
</tr>
<tr>
<td>SET</td>
<td>These buttons are used to set register values, to write them on the board.</td>
</tr>
<tr>
<td>Load</td>
<td>This button reads back the values from the device and updates the fields with the new values read.</td>
</tr>
</tbody>
</table>
3.2.6.2 **Calibration** TAB

The **Calibration** tab is used to calibrate the board. The user can change the values from the registers provided and read back the values changed. This tab will be used for testing purposes only. The part is calibrated in the factory.

![Calibration Tab](image)

**FIGURE 3-8:** The Calibration Tab.

The items found in the Advanced Setup menu, **Calibration** tab, are shown in **Table 3-8**.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GMCAL1/GMCAL2</td>
<td>Trims the transconductance of the error amplifiers.</td>
</tr>
<tr>
<td>DCSCAL1/DCSCAL2</td>
<td>Trims the offset of the 10x differential amplifiers.</td>
</tr>
<tr>
<td>ADBT</td>
<td>Trims the offset of the 1x/2x measurement amplifier.</td>
</tr>
<tr>
<td>DACBGRCAL</td>
<td>Trims the band gap reference voltage and the DAC modules’ currents.</td>
</tr>
<tr>
<td>PDSCAL</td>
<td>Trims the pedestal voltage.</td>
</tr>
<tr>
<td>VRCAL</td>
<td>Trims the 4.096V reference voltage.</td>
</tr>
<tr>
<td>OSCCAL</td>
<td>Trims the internal oscillator.</td>
</tr>
<tr>
<td>EACAL1/EACAL2</td>
<td>Trims the offset of the error amplifiers.</td>
</tr>
<tr>
<td>DACCAL1/DACCAL2</td>
<td>Trims the full range current of the DACs.</td>
</tr>
<tr>
<td>SET</td>
<td>These buttons are used to set register values, to write them on the board.</td>
</tr>
<tr>
<td>Load</td>
<td>This button reads back the values from the device and updates the fields with the new values read.</td>
</tr>
<tr>
<td>IS_GAIN</td>
<td>Contains the amplifier gain used to compute the output current values for each channel</td>
</tr>
</tbody>
</table>
3.2.7 Statistics Menu

The Statistics menu is used to monitor, in time, different A-D converter channels – parameters chosen from a selection box.

![Statistics Menu Image]

**FIGURE 3-9:** The Statistics Menu.

The items found in the Statistics menu are shown in **Table 3-9**.

**TABLE 3-9: STATISTICS MENU ITEMS**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Analog Test Interface</td>
<td>When this box is checked, the <strong>Set</strong> button is activated, the A/D Converter stops reading and the analog interface is activated. The parameters selected with the ADC selection box can be measured on the board.</td>
</tr>
<tr>
<td>ADC</td>
<td>Use this selection box to choose the characteristic to monitor.</td>
</tr>
<tr>
<td>Coordinate</td>
<td>All the characteristics monitored and displayed in the graph area are read with the A/D Converter.</td>
</tr>
<tr>
<td>Start</td>
<td>Use this button to start monitoring the chosen characteristic and to start generating the graph.</td>
</tr>
<tr>
<td>Stop</td>
<td>Use this button to stop scrolling the graph and to stop generating the graph.</td>
</tr>
<tr>
<td>Set</td>
<td>This button sets the analog characteristic that can be measured on board.</td>
</tr>
<tr>
<td>Graph area</td>
<td>This area displays the graph created while monitoring the chosen characteristic.</td>
</tr>
</tbody>
</table>
3.2.8 About Menu

The About menu includes the MCP19214_5Monitor version number.

![About Menu](image)

**FIGURE 3-10:** About Menu.

3.2.9 Help Menu

The Help menu opens the current user’s guide in PDF format.

3.3 USING THE MCP19214/5 GRAPHICAL USER INTERFACE

To perform the communication between the board and the PC, follow these steps:

1. Connect the board to the PC, using the on-board incorporated USB. The connector is automatically detected by the interface.
2. Change the option from the Rate drop-down menu if needed. The “5V” option from the Voltage drop-down menu and the “enabled” option from the Pullups drop-down menu are automatically selected.

![Connection Toolbar](image)

**FIGURE 3-11:** Connection Toolbar.

3. Press on the **ScanAddr** button. If the board is connected, the address will be shown in the Addr drop-down menu. If there are several addresses, manually select the correct address of the board from the list of available addresses (0x55 for the MCP19215 board). Then, press the **Connect** button for the communication to start running.

4. In the Hardware Setup menu, set the resistors for the output feedback divider and the output shunt resistor.

5. In the Basic Settings menu, under the User Settings panel, set the output voltage and current for each channel.

![User Settings Panel](image)

**FIGURE 3-12:** User Settings Panel.
6. Press the **ON** button to start the measurements for the output voltage and current. Press the **OFF** button to turn off the converter.

![Graphical User Interface](image)

**FIGURE 3-13:** Basic Settings Menu – Status Section.

To close the communication between the GUI and the board, press the **Disconnect** button from the Connection bar, then resume from Step 1.

7. In the Advanced Setup menu, change any parameter, as applicable, and click the **SET** button from the corresponding field with the changed data. The **Calibration** tab is used only for testing purposes.

<table>
<thead>
<tr>
<th>Channel 1</th>
<th>Channel 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>VIN 9.15 V</td>
<td>VOUT 0.09 V</td>
</tr>
<tr>
<td>TEMP 349 °C</td>
<td>IOUT 0.08 A</td>
</tr>
<tr>
<td>VOUT 9.21 V</td>
<td>IOUT 0.07 A</td>
</tr>
</tbody>
</table>

**WARNING**

It is recommended to read the “MCP19214/5 Data Sheet” before changing any values in the Setting or Calibration tabs.

8. In the Statistics menu (Figure 3-14), select one of the options in the “ADC” selection box to display the corresponding graph. The following options are available:

- When clicking the **Start** button, the time coordinate will be displayed on the X axis in seconds and the selected coordinate will be displayed on the Y axis using the corresponding measurement unit – ADC units.

**Note:** The **Start** button will be disabled until the **Stop** button is pressed.

- Clicking the **Stop** button will allow selection of another coordinate for generating the graph.
- If the **Enable Analog Test Interface** box is checked, the **Start** and **Stop** buttons will be disabled; the **Set** button will be enabled. Pressing on the **Set** button will activate the analog interface and the selected parameter in the **ADC** selection box can be measured.
9. The device calibration is now complete. Click the **StoreAll** button in the Basic Settings menu to retain the values after the device has been powered off, or on the **RestoreAll** button to return to the default values.

10. Disconnect the board from the PC to end the communication.